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About this session...

Target audience:
• Completely new to / curious about linux
• Some experience w/ linux, want to see Lotus apps on linux
• Want to feel confident installing Virtual Machine (VM)
• Need to run Windows apps (like Designer) on linux
• Ready for the crazier things like VPN and remote access

• ...not so much if you compile your own O/S builds, debate 
finer points of Gnome vs KDE vs other window managers, 
etc.
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Why linux? (and why not?)

Installing / running Notes & Symphony in native Ubuntu

Connecting via Virtual Private Network (VPN)

Ubuntu linux: download / install; what apps to use for tasks you'd want on any system

Install & configure a Virtual Machine to run Windows (and Designer / Administrator in Windows)

Connecting to remote machines

What we will cover in this Webinar

Linux Desktop:
From OS Install through Running the Applications
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About us...

• Notes / Domino developer for 15 years
• IT guy for 25 years (VAX/VMS system manager, Voice 

Response developer on OS/2, various proprietary 
languages ...prepped me for Domino web dev :)

• Presented Java-related sessions at Lotusphere 
• Wrote some for Lotus Advisor
• Linux user past 10 years
• Blog (not often enough) at http://www.joelitton.net/
• Twitter: joelitton
• Email: jrlitton@gmail.com

Joe Litton
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About us...

• Working with Notes since 3.0c, in 1993
• Architect, admin, auditor, trainer, process engineer, team 

lead, "reformed developer"
• Co-authored two IBM Redbooks on Linux; several 

publications
• Significant regulatory compliance and Domino specialty 

project experience
• Linux aficionado
• Blog at http://www.billmal.com/
• Twitter: billmalchisky
• Email: Bill@billmal.com

Bill Malchisky
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(and why perhaps not)
Why use linux?

T

Templates

FREE
(download free
 or buy a CD for about US$6.50)

Easy to use

Thousands of free apps

Probably works with your existing machine 
and peripherals (often more easily)

Needs fewer resources vs proprietary O/S

Fewer worries re viruses, etc

See: http://tek.io/linuxRocks

Pros

:) :(

Cons

Free support at http://ubuntu.com/support , 
but you'll need to buy support if you want to 
be able to speak to support tech

Some apps (like Domino Designer) don't yet 
run on linux (so you still need a Windows 
license to run within a VM)

Some devices can be harder to configure, or 
you need to search for linux drivers

See: http://zd.net/linuxSucks
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Ubuntu: download, configure, run

• Open a web browser and go to http://ubuntu.com
• Click the 'Download Ubuntu' button

Download
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Ubuntu: download, configure, run

• Click 'Start download'

Download
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Ubuntu: download, configure, run

• Specify where you want to save the file (and remember 
where you save it!)

Download
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Ubuntu: download, configure, run

• Scroll down a little on the download page, select CD or USB
• Select your O/S and click 'Show me how'

Create a bootable CD or USB drive
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Ubuntu: download, configure, run

• Detailed instructions with screenshots show how to create 
the bootable media, using the O/S you selected

Create a bootable CD or USB drive
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Ubuntu: download, configure, run

• Restart the target machine with your new bootable media in 
place (you may need to adjust BIOS for boot order)

• After a few moments...things start to load...

Boot and configure
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Ubuntu: download, configure, run

• Patience is a virtue. The ubuntu logo soon displays...

Boot and configure
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Ubuntu: download, configure, run

• Decide whether to TRY Ubuntu (no changes to hard drive), 
or install onto your hard drive (you may not get to MAKE the 
selection for a few moments)

• Note that wifi is automatically detected

Boot and configure
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Ubuntu: download, configure, run

• You'll want to have an Internet connection for the install, so 
provide the wifi password if needed (or plug in your network 
cable)

Boot and configure
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Ubuntu: download, configure, run

• Choose your password and enter it here...

Boot and configure
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Ubuntu: download, configure, run

• If you didn't get to make your Try / Install selection earlier, 
now is the time...

Boot and configure
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Ubuntu: download, configure, run

• This is why you need to remember your keyring password. If 
you've forgotten it, don't worry ...just restart the install

Boot and configure
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Ubuntu: download, configure, run

• These screenshots are for an install to the hard drive
• You want to be connected to the Internet in order to 

automatically update Ubuntu during the install

Boot and configure
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Ubuntu: download, configure, run

• I chose to use the entire disk, but you can install in a 
partition (a boot loader will automatically install for you, so 
you select your O/S at boot time)

Boot and configure
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Ubuntu: download, configure, run

• This is your last chance to change your mind :)
• If ready to proceed, click 'Install Now'

Boot and configure
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Ubuntu: download, configure, run

• Select your time zone

Boot and configure
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Ubuntu: download, configure, run

• Select your Keyboard layout

Boot and configure
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Ubuntu: download, configure, run

• Designate your name, how you want this computer to be 
listed on your network, your username, and your password.

Boot and configure
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Ubuntu: download, configure, run

• Ubuntu now has the info it needs, so kick back, grab some 
coffee, or read the screens to learn about Ubuntu while it 
installs

Boot and configure
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Ubuntu: download, configure, run

• Install is complete (well, for now), so click the 'Restart Now' 
button

Boot and configure
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Ubuntu: download, configure, run

• The username you specified will be showing. If multiple 
users accounts are set up in the future, this is where you 
would select your account. Click your username and enter 
your password

Boot and configure
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Ubuntu: download, configure, run

• I suggest allowing Ubuntu to check for updates daily. With 
this first boot up, you will have a number of updates to 
install, so click 'Install Updates'

Boot and configure
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Ubuntu: download, configure, run

• Ubuntu will require you to enter your password whenever 
you are updating software. This helps ensure that you 
realize that you are about to update your system.

Boot and configure
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Ubuntu: download, configure, run

• The Update 
Manager will tell 
you when all 
updates have been 
applied. You may 
need to reboot one 
more time

Boot and configure
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Ubuntu: download, configure, run

• Many devices run easily with Ubuntu. My Canon printer needed a driver to 
work over wifi. I had to go to
http://support-my.canon-asia.com/contents/MY/EN/0100236502.html
to find the driver

• Ubuntu is based on 'Debian', so look for .deb install files

Boot and configure
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Ubuntu: download, configure, run

• Downloaded files will typically be saved in your Downloads 
'Place'...

Boot and configure
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Ubuntu: download, configure, run

• Downloaded install files will typically be compressed 
archives. Double-click to open.

Boot and configure
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Ubuntu: download, configure, run

• In this case, the archive included multiple 'packages'; I 
double-clicked the packages folder to open it

Boot and configure
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Ubuntu: download, configure, run

• Finally the debian packages are available. When you 
double-click on a .deb file, the Package Manager will 
attempt to install the package (I did this once for each 
package)

Boot and configure
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Ubuntu: download, configure, run

• If this package were already installed, a 'Reinstall' button 
would display. Since this was the initial install of my printer 
drivers, I clicked the displayed 'Install' button (and entered 
my password when prompted)

Boot and configure
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Ubuntu: download, configure, run

• To complete the printer config, I clicked System > 
Administration > Printing

Boot and configure
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Ubuntu: download, configure, run

• No printers were showing yet. Click 'Add' to add / configure 
a printer

Boot and configure
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Ubuntu: download, configure, run

• The wireless printer was now available in the Network 
Printer section; when I selected it, the device URI displayed, 
and I clicked 'Forward'

Boot and configure
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Ubuntu: download, configure, run

• Ubuntu searched for (and located) the drivers

Boot and configure
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Ubuntu: download, configure, run

• The next dialog box required a name for the printer (it will 
make a suggestion), and optionally one can provide 
Description and Location fields. Click 'Apply' to save.

Boot and configure
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Ubuntu: download, configure, run

• You can see the printer now listed. The only remaining step 
is to verify the installation by printing a test page.

• It's important to note that I usually have not had to go to this 
much trouble to 
install a new printer;
usually Ubuntu sees
it right away and I 
simply select the 
driver from a list of
available drivers.

Boot and configure
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Ubuntu: download, configure, run

• Tens of thousands of applications are available through the 
Ubuntu Software Center, located on the Applications menu

Select and Install software

Linux aficionado
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Ubuntu: download, configure, run

• Before you select software, configure the software sources...

Select and Install software

Linux aficionado
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Ubuntu: download, configure, run

• Select Edit > Software Sources...

Select and Install software

Linux aficionado
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Ubuntu: download, configure, run

• I typically select
all options (except
Source code). If there
are copyright or
other licensing 
issues, you can 
read about that 
in each app's
listing.

Select and Install software

Linux aficionado
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Ubuntu: download, configure, run

• Similarly, on the
'Other Software'
tab, I typically
select all options.
Click 'Close' to 
save your
selections. 

Select and Install software

Linux aficionado
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Ubuntu: download, configure, run

• To add applications, you can browse the categories, or if you 
know the name of an app, just type it in the search bar. The 
example here is Skype

Select and Install software
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Ubuntu: download, configure, run

• Since I already had installed Skype, it the 'Remove' button is 
displayed instead of the 'Install' button.

Select and Install software
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Ubuntu: download, configure, run

• As the install window told us, Skype can be found under 
Applications > Internet > Skype 

Select and Install software
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Ubuntu: download, configure, run

• Since I have a webcam, I followed the same procedure to 
install the 'Cheese' webcam app as I followed to install 
Skype.

Select and Install software
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Ubuntu: download, configure, run

• Running 'Cheese' provides an easy way to test your 
webcam.

Select and Install software
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Ubuntu: download, configure, run
Some apps to consider...

file explorer Computer app, or Places
graphics, images manipulation GIMP, Shotwell, Shutter
photo management Picasa, Shotwell
web browser Firefox, Chrome
chat Pidgin, Skype, Gwibber
MP3 music & device management Rhythmbox, gtkpod (iPod mgr)
screen grabs Take Screenshot
Twitter, Facebook, LinkedIn TweetDeck (install Adobe Air first)

text edit gedit
backup SpiderOak
file transfers DropBox
calculator Calculator
webcam Cheese, Skype
music purchase Ubuntu One
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Ubuntu: download, configure, run

• The initial desktop background is kinda boring. To change 
the wallpaper, right-click on the desktop and select 'Change 
Desktop Background'

Customize the interface
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Ubuntu: download, configure, run

• The Appearance Preferences dialog lets you select from 
pre-loaded images,
add an image of your
own, or browse the
web for wallpaper.

Customize the interface
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Ubuntu: download, configure, run

• I clicked 'Add' and then selected an image that I'd 
downloaded in the past, and clicked 'Open' to save my 
selection.

Customize the interface

56Monday, May 16, 2011



Ubuntu: download, configure, run

• Ahh...That's more like it :)

Customize the interface
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Ubuntu: download, configure, run

• To organize the icons on your Ubuntu desktop, right-click
on the desktop
and select
'Organize
Desktop by
Name'

Customize the interface
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Ubuntu: download, configure, run

• The icons will now be displayed
in an orderly manner.

Customize the interface
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Ubuntu: download, configure, run

• To customize the menu, select System > Preferences > 
Main Menu

Customize the interface
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Ubuntu: download, configure, run

• To hide the Games menu, for example, uncheck Games and 
click 'Close'...

Customize the interface
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Ubuntu: download, configure, run

• The Games menu is now hidden. You can likewise 
rearrange the position of menus, and add / remove / hide 
menu options as you like.

Customize the interface
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Install & run Notes, Symphony
in native Ubuntu

• Download the IBM Lotus Symphony beta for Ubuntu at
http://www14.software.ibm.com/webapp/download/preconfig.jsp?id=2010-02-02+09%3A58%3A12.499225R&S_TACT=104CBW71&S_CMP=

• ...or search for “ibm lotus symphony beta for ubuntu” :)
• Be sure to select the version for Ubuntu
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Install & run Notes, Symphony
in native Ubuntu

• Symphony is free. You can log in or create a new account, or enter as a 
Guest after selecting the desired download

• Download Director will
typically result in faster
downloads. Click
'Download now' to
start the download.
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Install & run Notes, Symphony
in native Ubuntu

• By default, Download Director will create a folder under your 
home folder. Open the Computer app (or use the Places 
menu) to open your home folder, open the DownloadDirector 
folder, and look for the .deb file

• Double-click on
the symphony
install file (the
.deb) to begin the
install
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Install & run Notes, Symphony
in native Ubuntu

• Click 'Install' and the Package Manager will install Symphony (follow prompts 
to accept license agreement, etc)
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Install & run Notes, Symphony
in native Ubuntu

• When the instal completes, IBM Lotus Symphony will be 
listed under Applications > Office

(it really is just that easy)
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Install & run Notes, Symphony
in native Ubuntu

• Only the Notes client is available to run in native Ubuntu. 
You need access to Passport Advantage or other legitimate 
media source. The file I downloaded was called 
notes852_notes_linux_deb_cd4_prod.tar

• Navigate to the downloaded file. A '.tar' file is an archive, so 
double-click to open the archive

• Then double-click to allow the Package Manager to install 
ibm-lotus-notes-8.5.2.i586.deb

• Complete the install just as you would in Windows (provide 
server name, id file, etc)

68Monday, May 16, 2011



Install & run Notes, Symphony
in native Ubuntu

• Once you've configured Notes as you like, it looks pretty 
much the same as in Windows:
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Configure a Virtual Machine
to run Windows apps

• Domino Designer and some other applications only run in 
Windows. To do this with Ubuntu, install a Virtual Machine 
(VM), and run Windows within the VM

• The VM is just an app to Ubuntu
• You allocate disk and memory to the VM
• You can configure multiple VMs
• Various options exist; we will use VMWare Player
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Configure a Virtual Machine
to run Windows apps

• Go to http://www.vmware.com/go/downloadplayer/ to get the 
VMWare Player

• Register for a free account & log in once registered
• Once logged in, the download page displays. Select the 32-

bit or 64-bit Linux .bundle file
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Configure a Virtual Machine
to run Windows apps

• Follow instructions at https://help.ubuntu.com/community/
VMware/Player
to install the VMware Player on Ubuntu

• The first step is to select Applications > Accessories > 
Terminal to open a command prompt, and then issue this 
command (documented on the help page linked above):
sudo apt-get install build-essential linux-headers-`uname -r`
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Configure a Virtual Machine
to run Windows apps

• (The sudo command - substitute user do … or super user do - allows you to 
run privileged commands; hence, you are prompted for your password)

• Ensure that the downloaded .bundle file is executable (right-
click on the file to open Properties)
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Configure a Virtual Machine
to run Windows apps

• Back at the Terminal prompt, navigate to the Downloads 
folder (the cd command takes you to your home folder; 
cd Downloads will then take you to Downloads)
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Configure a Virtual Machine
to run Windows apps

• Copy the name of the .bundle file from Downloads (may be 
easiest from the Computer app or Places)

• Then in the Terminal window, type
gksudo bash ./
and use <Ctrl-Shift-V> ...or the menu ...to paste the name of 
the .bundle file after the typed text. Hit <Enter>
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Configure a Virtual Machine
to run Windows apps

• The VMware Player
installer runs and will
prompt you to allow
checking for product
updates. Follow the 
prompts

76Monday, May 16, 2011



Configure a Virtual Machine
to run Windows apps

• When done installing, the VMware Player will be available 
under Applications > System Tools > VMware Player 
(you can add this or any app to the top panel by right-clicking from the menu 
and selecting 'Add this launcher to panel')
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Configure a Virtual Machine
to run Windows apps

• Start VMware Player, insert your Windows install media in 
the CD/DVD drive, and click to create a new Virtual Machine
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Configure a Virtual Machine
to run Windows apps

• Follow the prompts...
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Configure a Virtual Machine
to run Windows apps

• Follow the prompts...
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Configure a Virtual Machine
to run Windows apps

• VMware Player will begin installing Windows in a new VM. 
When prompted, enter the Windows product key
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Configure a Virtual Machine
to run Windows apps

• Windows will automatically start up in the new VM
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Configure a Virtual Machine
to run Windows apps

• Now comes the nasty part: regular install of Windows, with 
the many updates and restarts

• Good news is restarts are all in the VM, so very fast
• I suggest disabling automatic updates once Windows is fully 

updated
• Each VM you configure is stored

as a folder in the vmware folder
under your home folder
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Configure a Virtual Machine
to run Windows apps

• Once you have your VM configured the way you like, use 
File > Suspend and Quit to exit the VM. This will make 
restarting the VM much faster. 
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Configure a Virtual Machine
to run Windows apps

• From this point onward, installing, configuring, and running 
applications in your VM is the same as on any Windows 
machine.

• I suggest DropBox
as an easy way to
move files among
physical and 
virtual machines
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Configure a Virtual Machine
to run Windows apps

• If your VM is primarily for running Domino Designer and 
Administrator, you may wish to load parts of Notes whenever 
the VM loads
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Configure a Virtual Machine
to run Windows apps

• Screen shot of Domino Designer running in VM

87Monday, May 16, 2011



Configure a Virtual Machine
to run Windows apps

• Screen shot of Domino Administrator running in VM

88Monday, May 16, 2011



Deep Dive

with Bill Malchisky
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Verifying Your Downloads

The powerful utility called md5sum
Computes and checks MD5 values (128-bit checksums) on files
Syntax: md5sum [option] ... [File] ...

So, $md5sum LotusTraveler_852_FP1.tar
Return value: 1d3538726b0d6077951ddfd995fb64f2 
LotusTraveler_852_FP1.tar

Verify this value against the value provided on the 
download site from your vendor

3
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Installing / running Notes & Symphony in native Ubuntu

Install & configure a Virtual Machine to run Windows (and Designer / Administrator in Windows)

Ubuntu linux: download / install; what apps to use for tasks you'd want on any system

Connecting via virtual Private Network (VPN)

Connecting to remote machines

Why linux? (and why not?)

What we will cover in this Webinar

Linux Desktop:
From OS Install through Running the Applications
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NetworkManager Applet

A great conceptual connection portal
• Stores Ethernet, WiFi, DSL, VPN, Mobile Broadband profiles

Heart and Soul of GUI Connections

3
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Recovery In The Face 
Of Adversary

What is the NetworkManager icon disappears?
$sudo service network-manager restart

Menu options to the rescue...
Main Menu

Wired Network
Wireless Networks
VPN Connections > {Available options} Configure VPN \\ Disconnect VPN \\ 

Righ-click Menu
Enable Networking / Wireless
Connection Info / Edit Connections...

4
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VPN Connections – 
Initial Considerations

Several VPN connection options
Much easier to configure in Linux

Splitting traffic in two easy clicks
Easy management too -- via NetworkManager’s VPN-aware menu branch

Increasing your changes for success
Library version gap -- what you have installed and what the vendor provides
What your admin allows -- they all allow  Windows
May need your key file for proper access

5

94Monday, May 16, 2011



95

VPN Connections – 
Getting Setup

The most common modules are for
PPTP – Microsoft,primarily
OpenVPN – Open VPN Server
VPNC – Cisco VPN

6
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VPN Connections – 
Getting Setup

Install the missing software
•Need: pptp-linux, network-manager-pptp

•Note: the “-gnome” is optional, but easy to add

•Open the Ubuntu Software Center
•Type in the package name, if you see green check mark, move on, else, 
install

7
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VPN Connections – 
Getting Setup

You can also just type it on the command-line, if you 
prefer

$sudo apt-get install network-manager-gnome 
network-manager-openvpn network-manager-pptp 
network-manager-vpnc

Here, network-manager-pptp will pull pptp-linux as a dependency, but you can 
add it to ensure success, if you wish

8
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VPN Connections – 
Adding Your Connection

9

NetworkManager offers plugin support for VPN modules, 
so by installing things, you can get what you need sans 
additional files or patches later.
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VPN Connections – 
Adding Your Connection

From VPN Tab, click Add
•Set type to PPTP

10
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VPN Connections – 
Adding Your Connection

Commence the data entry
•Will need the NT Domain, and 
IP for Gateway
•Note: depending upon how 
your admin configured the NT 
server, may need to append 
“.local” – try both ways

11
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VPN Connections – 
Advanced page

Lists all the CHAPs – 
MSCHAP, MSCHAPV2, and 
EAP inclusive

12
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VPN Connections – 
Adding Routes

Windows does add routes, 
Linux does not
You may need to add them 
yourself
Click on the IP V4 tab

13
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VPN Connections – 
Adding Routes

Leave Method as 
“Automatic (VPN)”
Click Routes...

14

103Monday, May 16, 2011



104

VPN Connections – 
Adding Routes

Click Add
Fill-in within each column, 
the appropriate values
Click OK when done
Keep metric to 1

Reboot!
(Yes, you read that 
correctly.)

15
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VPN Connections – 
Where Else to Go?

If you need additional troubleshooting assistance...
•The main PPTP site is really good

•http://pptpclient.sourceforge.net/howto-diagnosis.phtml

16
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Installing / running Notes & Symphony in native Ubuntu

Install & configure a Virtual Machine to run Windows (and Designer / Administrator in Windows)

Ubuntu linux: download / install; what apps to use for tasks you'd want on any system

Connecting via virtual Private Network (VPN)

Connecting to remote machines

Why linux? (and why not?)

What we will cover in this Webinar

Linux Desktop:
From OS Install through Running the Applications
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Alternate Access 
Mediums

RDP
•Many wonderful applications...

18
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Look Inside TS Client for 
Ubuntu – Main Screen

19
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Look Inside TS Client for 
Ubuntu – Display Tab

20
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Look Inside TS Client for 
Ubuntu – Local 
Resources

21
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Look Inside TS Client for 
Ubuntu – Programs

22
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Look Inside TS Client for 
Ubuntu – Performance

23
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Command line to the 
Rescue

Stubborn Network Recovery
For Ethernet DHCP connections...

Syntax: if[up down] <connection>

example: $sudo ifdown eth0
   Will stop a network device

24
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Ifdown eth0 Screen 
Output

RTNETLINK answers: No such process

There is already a pid file /var/run/dhclient.eth0.pid with 
pid 2470

killed old client process, removed PID file

Internet Systems Consortium DHCP Client V3.1.3

Copyright 2004-2009 Internet Systems Consortium.

All rights reserved.

For info, please visit https://www.isc.org/software/dhcp/

Listening on LPF/eth0/00:15:58:86:d2:55

Sending on   LPF/eth0/00:15:58:86:d2:55

Sending on   Socket/fallback

DHCPRELEASE on eth0 to 192.168.1.1 port 67 25
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Ifup eth0  Screen Output

Internet Systems Consortium DHCP Client V3.1.3

Copyright 2004-2009 Internet Systems Consortium.

All rights reserved.

For info, please visit https://www.isc.org/software/dhcp/

Listening on LPF/eth0/00:15:58:86:d2:55

Sending on   LPF/eth0/00:15:58:86:d2:55

Sending on   Socket/fallback

DHCPDISCOVER on eth0 to 255.255.255.255 port 67 interval 6

DHCPDISCOVER on eth0 to 255.255.255.255 port 67 interval 13

DHCPOFFER of 192.168.1.188 from 192.168.1.1

DHCPREQUEST of 192.168.1.188 on eth0 to 255.255.255.255 port 67

DHCPACK of 192.168.1.188 from 192.168.1.1

bound to 192.168.1.188 -- renewal in 16939 seconds.

26
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Ifconfig eth0 Output

eth0      Link encap:Ethernet  HWaddr 00:XX:XX:XX:XX:XX  

          inet addr:192.168.1.188  Bcast:192.168.1.255  Mask:255.255.255.0

          inet6 addr: fe80::215:58ff:fe86:d255/64 Scope:Link

          UP BROADCAST RUNNING MULTICAST  MTU:1500  Metric:1

          RX packets:108041 errors:0 dropped:0 overruns:0 frame:0

          TX packets:134470 errors:0 dropped:0 overruns:0 carrier:0

          collisions:0 txqueuelen:1000 
          RX bytes:73456524 (73.4 MB)  TX bytes:20617289 (20.6 MB)

          Memory:ee000000-ee020000 

27
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Ifconfig Output -- Part I

eth0      Link encap:Ethernet  HWaddr 00:XX:XX:XX:XX:XX  

          inet addr:192.168.1.188  Bcast:192.168.1.255  Mask:255.255.255.0

          inet6 addr: fe80::215:58ff:fe86:d255/64 Scope:Link

          UP BROADCAST RUNNING MULTICAST  MTU:1500  Metric:1

          RX packets:108041 errors:0 dropped:0 overruns:0 frame:0

          TX packets:134470 errors:0 dropped:0 overruns:0 carrier:0

          collisions:0 txqueuelen:1000 

          RX bytes:73456524 (73.4 MB)  TX bytes:20617289 (20.6 MB)

          Memory:ee000000-ee020000 

lo        Link encap:Local Loopback 

          inet addr:127.0.0.1  Mask:255.0.0.0

          inet6 addr: ::1/128 Scope:Host

          UP LOOPBACK RUNNING  MTU:16436  Metric:1

          RX packets:1065001 errors:0 dropped:0 overruns:0 frame:0

          TX packets:1065001 errors:0 dropped:0 overruns:0 carrier:0

          collisions:0 txqueuelen:0 

          RX bytes:168517072 (168.5 MB)  TX bytes:168517072 (168.5 MB)
28
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Ifconfig Output -- Part II

vmnet1    Link encap:Ethernet  HWaddr 00:50:56:c0:00:01  

          inet addr:192.168.115.1  Bcast:192.168.115.255  Mask:255.255.255.0

          inet6 addr: fe80::250:56ff:fec0:1/64 Scope:Link

          UP BROADCAST RUNNING MULTICAST  MTU:1500  Metric:1

          RX packets:0 errors:0 dropped:0 overruns:0 frame:0

          TX packets:605 errors:0 dropped:0 overruns:0 carrier:0

          collisions:0 txqueuelen:1000 

          RX bytes:0 (0.0 B)  TX bytes:0 (0.0 B)

vmnet8    Link encap:Ethernet  HWaddr 00:50:56:c0:00:08  

          inet addr:192.168.236.1  Bcast:192.168.236.255  Mask:255.255.255.0

          inet6 addr: fe80::250:56ff:fec0:8/64 Scope:Link

          UP BROADCAST RUNNING MULTICAST  MTU:1500  Metric:1

          RX packets:2649 errors:0 dropped:0 overruns:0 frame:0

          TX packets:605 errors:0 dropped:0 overruns:0 carrier:0

          collisions:0 txqueuelen:1000

  RX bytes:0 (0.0 B)  TX bytes:0 (0.0 B) 28
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Networking Tips

Reverse IP Lookup (getting the hostname for the IP)
dig +short -x <ip_address>

imac:~ tux$ dig +short -x 70.84.139.138
lincoln.websitewelcome.com.

29
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Package Management 
Contrasting

New to Ubuntu? Here’s a table to ease the translation 
from other Linux distros

Red Hat Ubuntu Comments

yum apt-get sudo apt-get install <package_name>

rpm dpkg sudo dpkg -i <package_file>.deb 
sudo dpkg -r <package_name>

sysvinit upstart No /etc/inittab Not ready for primetime

rpm -qi dpkg-deb dkpg-deb -I <package_file; archive>

rpm -q dpkg-query dpkg-query -l <pattern> -L <pkgname> 
-S <pattern>
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Linux Provides Some 
Command-Line Assistance

Typing along, then you utilize an uninstalled command 
– Ubuntu tells you and makes a suggestion:

tux@sardi:~$ jnettop

The program 'jnettop' is currently not installed.  
You can install it by typing:

   sudo apt-get install jnettop

31

121Monday, May 16, 2011



122

Dynamic Application 
Installation

tux@sardi:~$ sudo apt-get install jnettop

[sudo] password for tux: 

Reading package lists... Done

Building dependency tree       

Reading state information... Done

The following NEW packages will be installed:

  jnettop

0 upgraded, 1 newly installed, 0 to remove and 5 not upgraded.

Need to get 39.3kB of archives.

After this operation, 152kB of additional disk space will be used.

Get:1 http://us.archive.ubuntu.com/ubuntu/ lucid/universe jnettop 0.12.0-4 [39.3kB]

Fetched 39.3kB in 0s (49.2kB/s)  

Selecting previously deselected package jnettop.

(Reading database ... 222940 files and directories currently installed.)

Unpacking jnettop (from .../jnettop_0.12.0-4_amd64.deb) ...

Processing triggers for man-db ...

Processing triggers for menu ...

Setting up jnettop (0.12.0-4) ...
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THANK YOU!

Any Questions?

Your Logo
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SkiLUG
Is Almost Here!

25-27 Feb
Sunday River Resort

Join us! 
http://SkiLUG.org
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Joe Litton

The Consultant in your Pocket webcast series: find us at http://consultantinyourpocket.com

•E-mail:  jrlitton@gmail.com
•Twitter: billmalchisky
•Blog:     http://www.joelitton.net
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•E-mail:   bill@billmal.com
•Twitter:  billmalchisky
•Blog:      http://www.BillMal.com

Bill Malchisky
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